
ECUTEK ON NISSAN GT-R 
INTRODUCTION 
 
When working with EcuTek’s software and calibrations, you’ll be working with what are called  
“ROM files” (Read Only Memory). It’s important to understand that these read only files are the actual 
hard-coded instruction sets used by EcuTek and the car’s ECU to literally run the engine. These files 
are also commonly referred to as Maps, Tunes and Calibrations, and will be used interchangeably 
throughout these documents. Calibration is generally the most accurate depicter of a ROM file, since 
the ROM calibrates the ECU to a state where it can effectively and efficiently maintain control of the 
parameters that make the engine run. The Calibration is made up of dozens of Maps, which can be 

thought of as graphs, and which guide all individual parameters that are required for the engine to 
make power. When we Tune these Maps, we’re making adjustments for increased efficiency and 

better use of the many changing variables and environmental factors that affect the engine’s 
performance. The resulting collection of tuned maps is a Tuned Calibration. Therefore, you’ll be 
working with both your Stock Calibration, or “factory setup” and our Tuned Calibrations. 

 
So now let’s talk about “Flashing,” and what is actually occurring during this process. Just like with the 
ROM Dump process, when you flash your ECU, you’re using EcuTek’s ProECU software to exchange 

information between your laptop and the car’s ECU. But flashing the ECU differs in that you’re 
actually overwriting specific areas of memory that control the maps and other critical parameters of 
the engine. The purpose of this is to calibrate or tune the ECU to make better and more efficient use 
of its mechanical components. This allows us to create more power, new and improved features, 

better safety mechanisms, different fueling adaptations and in some cases, even increased fuelling 
efficiency. 
 
 

Your ProECU Kit 
 
 

 
 



Please Note: DO NOT plug either the USB Dongle or OBDII USB into your computer until drivers are 
installed! 
 

 
 
 
 
1. The first step we’ll need to take to begin this process is to install EcuTek’s ProECU Software on 
your laptop. Their software can be downloaded by visiting www.EcuTek.com and clicking on 
the Downloads tab at the top of the page. From there, simply follow the directions on the 

website and download the “EcuTek App Downloader.” 
 
2. When App Downloader is finished, double-click on it to begin the installation process. You’ll be  
met with the following introduction screens, which you simply need to click “Next” through.  
 

 



 
 
3. At this stage, you will be installing the drivers for both the USB Dongle Key and your OBDII-to- 
USB Cable. Again, for the smoothest installation process possible, PLEASE do not plug either 

device into your computer before the proper drivers are installed! All options on the Software 
Components screen should be checked by default, so click Next and Windows will ask you to  
verify the driver installation with the following window: 
 
4. It is highly recommended that you check the “Always trust software from EcuTek 
International” box, which will prevent this window from occurring again and also from windows 

hanging on the next driver install. After installing the drivers for both devices you’ll be using 
to run the ProECU Software with, you’ll be asked to plug each one in separately beginning with 

the OBDII cable. Luckily the installer uses pictures to show when to plug in each device, as 
shown below. 
 
5. After the drivers for both devices are correctly installed, you should see a confirmation bubble 
pop up from the taskbar, as seen in the image below. This confirms that both devices were 
recognized and installed correctly with the proper drivers. 
 

 
 
6. Leave both devices connected as you proceed through the rest of the installation. Next 
EcuTek’s App Downloader software will update all components of the ProECU software with the 
latest patches and revisions. It is very important that you allow all updates to be downloaded 
and installed! 
 



 
 

 
 

 
 
 
7. After the notification above pops up stating, “Your ProECU installation has now been 
updated,” the entire ProECU Software installation has completed successfully, and all updates  

to the core components have been made. But we’re not done quite yet! Now that the 
software itself is completely up-to-date, we need to make sure it also has the latest database 
of manufacturer configuration files, ECU ID’s, and everything else to identify the latest models.  



 
8. The first time you open ProECU, you’ll be asked for one last round of updates, which again is to 
ensure compatibility with the latest supported makes and models. 
 
9. And finally, after all updates are successfully installed, you’ll be left with a simple, elegant  
ProECU Software bar, like the one you see below. Also notice the two solid green lights on the 
ProECU bar, which indicate proper communication with the CAN & K-Line interface of the OBDII 
Cable. You are now ready to proceed to the next section of this guide! 
 
 
 

How to Flash your Engine calibration file 
 
 
1. After successfully obtaining the Tune Calibration file by email, next you’ll need to load up EcuTek’s 
ProECU software. You should also get in the habit of closing all unrelated programs down and 

disabling your anti-virus before any flashes. It’s good practice to eliminate as much 
“interference” as possible beforehand, because once you reach the point where you’re passing  
files to and from your ECU, it is very important that the process go uninterrupted. 

 
2. With your calibration file saved and the included USB dongle key plugged in, let’s go ahead and  
establish the link we need between the ProECU Software and your car’s ECU. Start by locating  
your car’s OBDII port, which is under the dash/steering column on the left hand side, right  
under the hood release pull.  
 
3. With the OBDII Cable securely plugged into the car’s OBDII Port and its single solid green light  
confirming the connection, plug the USB end of the OBDII Cable into a free USB port on your 
computer, keeping in mind that the USB Dongle Key must remain plugged in while running ProECU. 

As we saw during installation, the ProECU Toolbar should confirm the connection by lighting up green 
in the right hand status boxes. 
 
IMPORTANT: at no point during either the ROM Dump or flashing process will you be 
starting your engine. Any reference or instruction to “turn the car on,” means turning the  

key, or pushing the start button to the ON position. The best way to avoid any accidental  
engine starts is to keep your feet off all foot pedals while you are linked to the OBDII port. 

 
4. Another good habit to be in before you begin any communication with the ECU, is to make sure  
all accessory switches are in the off position. This includes your headlights, HVAC system 
(A/C), and even your stereo and Bluetooth accessories. It’s also important to make sure both 
your car’s battery and your laptop are fully charged. Again, we don’t want any disruptions 

while connected to the ECU. If all of the above steps have been followed and you have the two 
green status lights in the toolbar, you’re ready to begin flashing your ECU. Go ahead and turn 
your key (or push start button) to the on position. 
 
5. First we need to have the software detect your vehicle so it can load the correct ProECU Tools.  
To do this, click on the Tools menu in ProECU -> then click Detect Vehicle and let the software 

try and figure out which car you have. 
 
If it fails to detect your vehicle, you’ll most likely see the following error message:  
If that’s the case, make sure that all drivers were installed correctly and neither the USB 
Dongle nor OBDII Cable were plugged in prior to the driver install. Also, be sure that the car is 

in the “ON” position (as opposed to just the accessory or “ACC” position), that all software 
updates were downloaded and installed and that you still have two green status lights. 
Alternatively, you can manually select your vehicle by choosing that option, which is also found 
under the Tools menu. 

 
6. After a successful detection, made by choosing Detect Vehicle (or by manually selecting it), you 
should see the Select Tuning Tool window come up, shown here on the right. From here you will see 
the option to Program Engine ECU (which should be the top choice). Select Program Engine ECU 
and click OK. 



 
7. In some instances, you will receive a warning message saying “You are not running the 
recommended vehicle interface driver version.” As long as the Installed Driver Version is higher 
than the Recommended Driver Version, this is nothing to worry about. If not, there are still 
updates that need to be installed. Click OK to advance to the next screen. 

 
8. The next window that loads will be the ECU Programming Tools Window. The 

diagram below highlights the important buttons you’ll be using and what they do.  
 
9. In order to flash the ECU with a specific calibration, you must select which file to use by 
clicking “Choose ROM File,” circled in red above. Navigate to the desktop or wherever you 

saved your calibration file from Step 1, select it and click “OK.” This will load the calibration 
file into the “ROM File to Program” window, right above the Choose ROM File button. 

 
10. Also under the category of “good habits to be in,” pressing the Query ECU button before any 

procedures will ensure an active connection exists between the ProECU Software and the car’s 
ECU. If after clicking Query ECU, you see the log file in the right hand window update with 

new information, you’ll know there is an active connection responding from the ECU and you 
are clear to proceed with flashing in the new calibration file you selected by clicking “Program 
ECU”. 

 
Troubleshooting: If you have an unsupported ECU, the following warning message is produced:  
If after clicking “OK,” you’re met with the warning message below, your ECU has most likely  
already been flashed with another Calibration. Please contact us if you receive this message so that 
we can help you remove the existing calibration and replace it with the EcuTek Tune calibration you 
purchased. 
 
11. After clicking “Program ECU,” the process of transferring the new calibration file from your 
laptop to your ECU will begin. Again, it can’t really be stressed enough; it is very important 
that this process and any process where information is being sent to and from the ECU, not be 
interrupted! You can keep track of the progress of the transfer in the lower left hand corner 

of the “Programming Tools” window, as shown below. 
 
12. Once the process is complete and the calibration has been transferred, you’ll be asked to cycle 
your ignition a few times. The first message will ask you to cycle the key to the OFF position.  
The software will tell you when to cycle the key back to the ON position which generally 

takes about 10 – 15 seconds. After the first cycle, you’ll be asked to repeat the process one more 
time, and finally you’ll be presented with the “Programming sequence is now complete” message, 

shown below. 
 
13. That’s it! You’re done flashing the new Tune Calibration. If this is your first time flashing  
the car, make sure you remember to continue into the next section to install the 
updated TCM Software. 

 
 

How to Flash your Transmission calibration file 
 

STEP-BY-STEP INSTRUCTIONS ON HOW TO FLASH IN UPGRADED TCM SOFTWARE 
1. Having just completed the previous section, you should have already downloaded the updated 
TCM Software (which is in the same format, .bin) and saved it in the same place as the Tune 

Calibration.  
 
2. If continuing you should still be connected to the car. If not, proceed to it with 
laptop, OBDII Cable and USB Dongle in hand. Plug in both USB Dongle and then OBDII Cable 
(USB end) into laptop and load up ProECU. You should now have the two green status lights lit,  
like you saw in Section 5, “Step-By-Step Instructions to Flash in Tuned Calibration” 
 
3. Like always, make sure all accessory switches are in the off position, including headlights, 

HVAC system, stereo and all Bluetooth accessories. Plug the OBDII end of the cable into your  



car’s OBDII port and turn the car to the ON position (keeping in mind that at no point during 
this process will you be starting your engine). 

 
4. With all connections between your computer and your ECU intact and with ProECU software 
still up and running from the ECU Flash, click on the Tools menu. Since your car has already been 

detected, you should now see the “Nissan GTR R35” menus in the Tools menu. Since we’re flashing 
in the updated TCM Software, choose “Nissan GTR R35 Transmission ECU -> Program Transmission 
ECU” to bring up the “Program Transmission ECU” window, which looks nearly identical to the 

Program Engine ECU window. 
 
5. With the “Program Transmission ECU” window up, go ahead and click “Query ECU” to make 

sure the software and your ECU have an active connection. The log file on the right side of the  
window should update with information about your ECU. After Querying ECU, click on “Choose 
ROM File” and select the updated TCM Software file. With an active connection to the ECU and  
the updated TCM ROM File loaded, we are now clear to proceed with the Transmission flash.  
Go ahead and click “Program ECU.” 

 
6. FROM THIS POINT FORWARD, it is absolutely imperative that there are no interruptions while 

the ECU is being flashed. You can monitor the progress of the flash in the lower left hand 
corner of the Programming Tools window just like you did with the Engine ECU Flash. Once the 
flash has finished uploading the calibration file to your Transmission ECU, you will be prompted  
to “Switch Ignition Off.” You may be asked to repeat this process a couple more times, as you 

did in the previous section. 
 
7. Finally, you will see, “Programming sequence has now completed.” This means of course,  

the TCM flash has now completed successfully and it is safe to disconnect the OBDII cable and 
start your engine! 

 
After that, your car is OFFICIALLY remapped and you’re ready for your first test 

drive! 
ECUTEK PROECU TOOLS FOR GT-R 

 

 

EcuTeK ProECU TOOLS 
 
 

EcuTek has developed several special tools for various modules on the GTR. 
Special Tools are available for the ECM, TCM, ABS and TPMS modules. The special 

tools can perform an unprecedented level of features that have never been available to 
the aftermarket and tuning industry. 

 
Some of these features include: 
 

Clutch Pressure Adjustments 
Clutch Touch Points Adjustments 

Temperate and Warning History read/clear 
Gearbox Learning 

Steering wheel sensor calibration 
Idle Learning/Bank Learning 

Power Balance 
Brake Sensor calibration 
Tire Pressure Sensor registration 

 
 



ECM Tools 
 

 
 
Reset ECU – This will clear all learnt values for Idle Control and Fuel Trims 

 
Idle Learning/Bank Learning – This will commence an auto learn airflow/throttle 
balance sequence, ensure that the Engine and TCM are over 65 deg C, the vehicle is in 

Park with handbrake ON and no DTCs are current or historic then start the auto learn 
sequence. 

 
Power Balance – Will cut individual fuel injectors to help isolate problem cylinders 

 
ABS Tools 
 

 
 
Steering Wheel Angle Calibration – This should be used to calibrate the steering 
wheel alignment for the driver display and other modules, set the steering wheel in the 

straight ahead position then start the calibration process. 



 
Decel G Sensor Calibration – Ensure the vehicle is on level ground, in PARK, 

Handbrake ON with steering wheel straight ahead position. 
 

Brake Pressure Sensor Calibration and Brake Pressure Valve Calibration – Ensure 
the vehicle is on level ground, in PARK, Handbrake ON with steering wheel straight 

ahead position before commencing this test, you will hear noise and experience 
movement so be prepared! 

 
Tire Pressure Monitor System 
 

 
 
Using the widely available Nissan TPMS it’s now possible to reset the TPMS light. 
Start the registration sequence then visit the indicated wheel and press the button on the  

handheld TPMS tool for registration. Please contact if you would like to 
purchase one 

 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
TCM Tools 
 

 

 
 

Clutch Gear Learning 
 
This process will initiate the TCM ECU to self-calibrate the clutch pressure, clutch touch 

points along with pump and solenoid duty learning. 
Once the sequence starts it should be allowed to complete fully and takes around 5 

minutes in total. 
The vehicle should be up to temperature with coolant temp over 176 deg F and Gearbox 

oil temp over 149 deg F. 
The vehicle should be on a level smooth surface while steering wheel is straight. You 

should be in the driver seat of the vehicle whilst the learning sequence is active.  
It is normal for the engine rpm to rise and fall during the test. 
The vehicle will also shunt back and forth during the test as the gears and clutches are 

engaged and disengaged. 
Once the learning sequence is complete the learned values can be checked under Read 

Learned Data. 



 
 

 
 

Clutch Touch Points 
 

These touch points are the actual engagement point of the clutch plates to connect the  
engine crankshaft drive to the input shaft of the gearbox. 

It's the bite point which normally is experienced when raising the clutch pedal on a 
vehicle fitted with a conventional manual gearbox. 
There are two gearbox shafts, Bank A (even gears 2-4-6) and Bank B (odd gears 1-3-5). 

With the gearbox in Drive (manual or Auto) press the accel pedal so that the engine rpm 
rises, the clutch will engage and the vehicle will start to creep forward. 

On a poorly calibrated touch point where the value would be below 8 (example 5) the  
engine rpm will rise too high (around 1200-1400rpm) and the vehicle will not really move 

forward, and then suddenly the clutch will engage causing an unpleasant jolt forward.  
If the Touch point is too high the clutch will be engaged at idle and if the foot brake is on 

to prevent the vehicle from moving then the clutch will be slipping creating heat and 
excessive wear, when the foot brake is released (off) the vehicle will creep forward, as 

the accel pedal is pressed the clutch is already partially engaged and any accel 
movement will directly increase the vehicle speed further. 
The setting required for each bank should be trial and error as each vehicles tolerance 

and amount of wear may be different. 
The touch points should be increased until the vehicle just starts to creep and then 

reduced by a value of 1 so that the vehicle can almost move forward on a smooth 
surface. 

 
Clutch Pressure: 

 
The Clutch pressures are applied for each clutch: Clutch A (even gears 2-4-6) and clutch 
B (odd gears 1-3-5). Raising the clutch pressure values will give a more positive pull 

away and gear change, reducing these values will encourage clutch slip along with a 
smoother pull away with smooth undetectable gear changes. On high power vehicles 

these pressures should be increased to minimize torque slip on gear changes. 
 

Read Clutch Temps – This will display the maximum clutch temps that have been 
achieved 

 
Read Oil Temp History – This will show the Oil Temp history including frequency of oil 
temp . 

 
Read Warning History – This will display any protection thresholds that have been 

triggered. 
 

Clear Warning History – This will clear the TCM warning history. 
 

Reset Clutch Adjustment – These will clear and reset all current Clutch Capacity or  
Touchpoints. 
HOW TO CONDUCT ADVANCED DATA LOGGING FOR TROUBLESHOOTING & REVIEW 

 
 



Live Data Logging 
 

 
 
Data Logging is an important tool we use to get an extremely detailed representation of 

how your engine is performing. It will record and log several key variables that are 
instrumental in assessing engine health and performance, and allow us to quickly 

diagnose any issues that may arise or even find areas of the calibration that can be 
better adapted to your specific vehicle or setup. 

 
After flashing in the Tune calibration, we recommend running a datalog shortly 

thereafter, and emailing for review. Here’s how to begin the process: 
 
1. Start by loading up the EcuTek ProECU software, making sure that the USB Dongle 

Key is connected beforehand. With the ProECU bar loaded, go ahead and connect 
your laptop to your car’s ECU using the OBDII-to-USB cable. Just like in the 

previous sections, you should have the two green status bars in ProECU and an 



active green light on the OBDII cable confirming the connection with the ECU. 
 

2. With everything linked up between your car and your laptop, go ahead and start your 
engine. To open the Live Data window, you simply need to open the most recently 

flashed ROM file sent to you in the calibration request. You can do this two ways. 

You can select File -> Open ROM File and navigate to where the Tune Calibration is. 
Or if you saved it to the desktop, per the suggestion in Section 6 – Step By Step 
Instructions to Flash in Tuned Calibration, you can simply drag the ROM file from the 

desktop to the ProECU Toolbar to open it. 
 
3. With the ROM File open, you can see the large list of variables (shown to the right) 

that can be logged with the ProECU software. However, even though your engine is 
running, you won’t see them updating in real-time just yet. Also notice that each variable 

has a check box next to it which you can use to select whether the data from this 
parameter is logged or not in the data file you’re about to produce. Don’t worry about 

which variables need to be checked and which ones don’t. By default, we have already 
set this list up to monitor the important ones we want you to log. 

 
4. The first time you datalog using ProECU, you’ll want to set up a few things in the Live 

Data window. It is suggested that you show the additional columns for minimum and 
maximum values for each parameter. To do this, right click in the toolbar under “Live 
Data” where “Name, Units, and Current” reside and click on the options to show 

“Minimum” and “Maximum,” as shown in the picture to the right. This of course will keep 
track of the spectrum of the variables and the range they extend to and from, which is 

important. After enabling these columns, click View -> Save Rom Editor Layout as 
Default to save this view as the default. 

 

 
 



 
 
5. With everything loaded up and connected, we’re ready to open the connection 
between the OBDII port and your laptop. Go ahead and click on the “Map Access” 

button to begin this connection and start the flow of data. You should now see the 
Current, Minimum and Maximum categories updating and changing in real time. 
 
Important: If you get the following error message after clicking on “Map Access,” the ROM file you have opened 
does not match the contents of your ECU, which means you have not flashed in the ROM file you have opened 

and are attempting to log. You must be using the most recently flashed ROM file to log data. 
 
 

6. After clicking Map Access, you should notice a couple of things. The Map Access 

button is now highlighted and you have a new status bar that appears above the list of 

variables that shows a cycling green status bar. This indicates an active connection and 
streaming data from your ECU. Also notice the status bar currently has a RED rectangle 
around it, which indicates the data is not being recorded. To begin logging the 

parameters that are checked in the data log window, 
simply click the “Log To File” button. 

 
7. Once Log To File is enabled, you will see the button itself highlighted (just like the 

Map Access button) and the RED rectangle from before will change to GREEN to 

confirm that the data is now being logged. The log will be continuously recording 
the output from the engine until the button is pressed again to  stop logging. 
In order to produce the best datalogs, you’re going to want to show a couple of  

WOT (wide-open throttle) pulls, preferably in 3rd gear to show sufficient load on the 
engine. Second gear pulls are acceptable but do not provide as much time or detail 

to pinpoint any issues that may be occurring. 
 

8. After logging a few pulls and a few minutes of normal driving, you can comfortably 
end the log session as this will more than likely produce enough data to get an 

accurate read on the health of the engine. After you’ve safely pulled over and 
parked, go ahead and click the ‘Log To File’ button again to end the log session. 
This will produce and save a time-stamped log file to the default logging folder, 

which can be found at C:\EcuTek\MapAccessLogs. 
 
Tip: The full path and filename will be shown when you hover the mouse over the Log To 
File button. 

 

9. After successfully producing the log file, you’ll want to email the file 

RACEROM FEATURES & HOW TO TAKE ADVANTAGE 

 
 
 



Map Switching 
 
The Map Switching feature allows you to switch between up to four different maps built 
into a Calibration. You can switch between the maps at the press of a button. Hold down 
the cancel button for approximately 1 second and you’ll see the tachometer point to the  

currently selected map. Use the “RES/ACCEL” button to press up and advance the map 
selection by one. This selection will be indicated by the tachometer pointing to 1,000rpm 

for Map 1, 2,000rpm for Map 2, 3,000rpm for Map 3, 4,000rpm for Map 4. Pressing the  
“COAST/SET” button moves the map selection down by 1. 

 
RaceROM Boost Controller 
 

The RaceROM Boost Controller feature allows you to adjust the maximum desired boost  
using the cruise control buttons (when the cruise control is off). The boost level selected 

is displayed on the dashboard monitor. 

 
Method of Operation 
 
Ensure the cruise control is switched off. 
Press "RES/ACCEL" or "COAST/SET" to display the current desired boost. 
To increase desired boost by 1 PSI, press "RES/ACCEL" 
To decrease desired boost by 1 PSI bar, press "COAST/SET" To increase desired boost to maximum, 
hold "RES/ACCEL" for 2 seconds. 
To increase desired boost to minimum, hold "COAST/SET" for 2 seconds. 
After 2 seconds, the monitor display will revert to normal. 

 
 
RaceROM Valet Mode 
 
Valet Mode allows the driver to lock the car into a lower performance mode when 
lending it to a less experienced driver. It can also be used as a supplementary anti-theft 

system. We do not recommend that car owners rely on it as their only anti-theft solution. 

 
Method of Operation 
 
To turn on the Valet mode 
Engine On or Off, in Park, E-brake Up, Cruise Control On, TV showing Coolant Temp gauge. 
Hold CANCEL for 1 second, coolant gauge changes, cruise set light starts to flash slowly. 
Use cruise up/down button to choose a PIN number on coolant temp gauge 
Press CANCEL to engage valet mode. 

 

To turn off the Valet mode 
Engine Off, Ignition On, Cruise Control On, TV showing Coolant Temp gauge.  
Hold CANCEL for 1 second, coolant gauge changes, cruise set light starts to flash fast. 
Use cruise up/down button to enter the correct PIN number on coolant temp gauge 
Press CANCEL to validate the code. 
Coolant temp shows *** for correct code or red for wrong code. 

 
Wrong code timeout 

 



After 3 incorrect attempts, the system will not let you try again for 5 minutes. This is to 
discourage somebody from trying all of the possible codes. 

 
 

RaceROM Launch Control (RRLC) 
 

 
 



 
 
EcuTek have developed RRLC so the Launch RPM can be adjusted LIVE during the 

Launch Mode. This allows the driver to select the optimum launch RPM (and therefore 
engine power output) for the current conditions. 

RRLC allows the driver to adjust the launch RPM by pressing the cruise control 
“res/accel” and “coast/set” buttons while the launch control system is active. 

With launch control active, whilst fully depressing the accelerator pedal, Press the 
“res/accel” button to raise the launch RPM. Press the “coast/set” button to lower the 
launch RPM. 

The default Launch Control RPM (set in the ECM ROM) will be used after ECU 
Programming, ECU Reset or disconnecting the battery. 

 
Nissan Factory Launch Control Overview 
 
The Nissan GTR has a built in factory Launch Control Mode, when conditions are correct 

this will deliver an extremely effective launch condition. When entering the special mode 
the throttle butterfly will react quickly providing a burst of Engine Torque which will load 
the transmission and drivetrain for a blistering launch condition. 

This launch condition is often mistaken and confused for the typical ‘stall test’ launch 
that can be induced by on most Auto gearboxes models at the traffic lights (left foot on 

the Brake, Accel pedal to the floor and wait for the lights to change). This low torque/low 
RPM slipping convertor/clutch launch is not the same or nearly as aggressive as the 

special Launch Control Mode, though this type of launch is still very effective on the GTR 
when used. 
 
How do I make the Nissan GTR Launch Control Work? 
 

When the Engine and Gearbox oils are up to temperature, the vehicle is stationary, then 

the factory launch control can be used. With your left foot on the brake and quickly 
pressing the Accel pedal to the floor, the engine RPM will rise very quickly to around 



4500rpm, this RPM will be held for around 5 seconds until the ECU will force release of 
the LC mode to prevent strain and heat on the clutches and gearbox. 


